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Introduction

What are Activity Funds?

Activity funds are generated and accumulated by the school from the collection
of student fees, school-approved fund raising, and other activities. These funds
are held “in trust” by the school and are used to promote the general welfare of
the school and educational development and morale of all students.

School Board Governance of Activity Funds Management Accounting —
Columbia-Brazoria ISD Policy - CFD Legal and Local.

There are (2) main categories of activity funds:

Student activity funds (SAF) are funds generated by specific student groups,
not by the district or campus. Decisions about the expenditure of these funds
are made by the students. These accounts are 100’s,

Campus activity funds (CAF) are funds raised locally at the school or donated
to the school and include school office and departmental accounts. Campus
activity funds are considered by TEA to be district general funds. The
expenditure of these funds must comply with state and board policy and with
district regulations. These accounts are 200’s.

Pass-Through Accounts - These accounts are created for Library Books (lost
books), Textbooks (payments for lost or damaged books), and Art fees or
Calculator money collected. They are basically an in/out situation and are
closed out at the end of each fiscal year with the balances sent to the District
Office. Textbooks, Library books, and Calculators are purchased through
District Funds, and therefore any payments made to replace them needs to
return to the District.

*PLEASE NOTE - To insure the requirements of the District’s Tax

Exempt status....”no part of the net earnings of the organization may insure to
the benefit of any private party or individual other than as reasonable
compensation for services rendered to the organization.” In short, NO
individual student accounts may be utilized.
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Activity Funds Accounting

Columbia Brazoria 1.5.D. uses a decentralized accounting and bank
reconciliation system. Activity is entered and processed by the campus
bookkeeper. Funds are accounted for and controlled by the various school
sites, audited monthly by the Business Office, and audited annually by
independent auditors.

All records should be kept current and in good order for a period of five years
and available for audit at any time.

Bank Accounts

One bank account for each campus will be maintained for the activity accounts
at the school district’s depository bank. Columbia Brazoria 1.S.D.’s current
depository bank is Prosperity Bank of West Columbia.

ALL financial transactions for campus clubs and activities must be accounted for
through the campus activity bank accounts.

¢ All cash and checks received for the activity fund must be deposited to
the bank and all payments must be processed with a check written on
the bank account. NO transactions should be made from cash. NO
checks should be made to CASH. NO BLANK CHECKS should be used
for purchases.

e Each campus may maintain only ONE checking account at the district
depository. Opening of additional bank accounts or purchases of
investments with activity funds are not allowed without prior written
approval from the Board of Directors.

e Each campus will have a checkbook that must be secured in a locked
location when not in use.

¢ Each check shall require two signatures.

o Each bank account shall have up to five authorized check signers, one of
which shall be the principal. The campus secretary/bookkeeper, or the
person responsible for writing the checks, should NOT be a signer.

o Each check should be manually signed and under NO circumstances
should checks be pre-signed. Checks must be written and signed at the
time they are needed and with proper documentation. All checks must
indicate the payee and the dollar amount before being signed. (NO
BLANK CHECKS.)

- ——
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¢ Prompt reconciliation of the Activity fund bank account is one of the
most important aspects of the secretary’s job. It is the Principal’s
responsibility to see that the financial secretary has adequate time to
complete the bank reconciliation on time each month.

Petty Cash

As stated above, NO TRANSACTIONS SHOULD BE MADE FROM CASH. The
only exception was approved by the Chief Financial Officer, and involves the
Junior High and High School Band accounts.

Both the Junior High and High School bands have the need to maintain a
small petty cash fund in order to make change for the essential
band/instrument supplies sold to students, such as reeds and oil. This fund is
approved with the stipulation that a monthly reconciliation be performed by
the Director with receipts, and excess cash turned in to the School Secretary.
This fund shall initiate from the Band Activity Fund in the amount of $50.00 at
the beginning of the school year, and all cash remaining, along with receipts,
needs to be closed out and turned in at the end of the school year.

As a reminder, all student purchases for personal use MUST be charged sales
tax. These sales must be reported quarterly via your Activity Fund Sales
Reports.

Information for Activity Fund Sponsors

Sponsors — Only certified personnel may be assigned as official sponsors of
Activity Fund Accounts. Paraprofessionals may continue to assist with the
collections and preparation of various paperwork for the accounts. Parents
and students may continue to help with the activities and count money.
However, the official sponsor (administrator, teacher, counselor should be
cognizant of all account activity and should sign off on all check requests
and deposits. The sponsor is also responsible for reconciling the account
with the school secretary/bookkeeper.

CBISD, Rev. 8/8/2020
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Fund Raising

The Superintendent must pre-approve all fund-raisers.

School Board Governance of student fund raising — Columbia-Brazoria
ISD Policy - FJ Legal and Local.

e The Sponsor is responsible for maintaining accurate records of all
sales activities and accounting for all items purchased from vendors
for resale.

® Sponsors should take care to select a reputable company and
maintain a good relationship with district vendors by submitting bills
to the bookkeeper for payment in a timely manner.

¢ The District supports utilizing our Local Vendors, and in doing so, it
is requested that vou provide Quotes from at least {3] Vendors.

e Sponsors must keep control of the merchandise and money. Both
should be secured at all times. Deposit funds with the bookkeeper
regularly (daily is recommended). NO CASH should be held over the
weekend, and all monies must be turned in to the Secretary along
with an accounting for deposit by Friday. A Receipt should be given
by the Secretary for all funds turned in for deposit.

¢ Sponsors should keep good records of merchandise that was
distributed to students and monies turned in. Notify your campus
administrator if student obligations are not paid.

e Ralffles are not allowable fund-raisers for the school district or activity
fund clubs.

e It is recommended and highly stressed, that for the safety of our
students, NO DOOR TO DOOR Solicitation be done by students.

Authorization to Conduct a Fund Raiser Form

1. This form is used to request pre-approval for all fund raisers, provide for
placement on the school/district calendar, and provide an accounting of
the fund raising activity, including sales tax collected, and payable to the
state.

2. The sponsor will complete the top portion and submit the form to the
principal, who will sign off, and forward a copy to the Superintendent’s
office for approval. A copy will be returned to the Principal, who, in turn,
should return the approved/denied form to the sponsor.

3. The middle portion of the form will be used by the sponsor to keep track
of deposits and expenses related to the fund-raiser that are submitted to
the Principal’s Secretary. Each deposit should be receipted as described
in this manual. (see Receipting Funds Collected, pg.11)

4. Once complete, the Club Treasurer and Club Sponsor should sign at the
bottom and forward a copy to the School Secretary

CBISD, Rev. 8/8/2020
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5. .Crowd Funding

What is “Crowd Funding”? The method of raising capital through the
collective effort of friends, family, coworkers, and parents primarily through
social media and online crowdfunding platforms. (Including DonorsChoose,
GoFundMe, Fundtube, AdoptAClassroom, Kula, Incited, etc.)

When it comes to providing quality educational experiences for our students,
CBISD teachers and staff are creative and resourceful. While the District is
supportive of new and innovative methods to help reach our mission, we must
also implement guidelines to protect both employees and the District.

Requirements

District Staff shall not utilize an external donor website to seek donations
for the District without written authorization from the Superintendent by
completing the “Authorization to Conduct a Fundraiser” Form. (Even
when the donation is non-monetary.)

Include the District Name, Campus and teacher name.

Set a project deadline of 45 days.

Provide information to donors regarding service fees.

Follow district purchasing requirements when/if funds are collected.
Ensure technology items meet the district’s technology requirements

Be sure that donations received and items purchased from donations for
the campus remain on that campus.

Satisfy the requirements of the online site. (No photos of students should
be used.)

Report donations received to the Business Office.

Donor websites shall not be established by the District for the personal
benefit of a staff member or student, however, if a staff member or
student establishes a “personal donor webpage”, NOT in the name of the
district, the webpage may be distributed via district email to all staff with
the authorization of the Superintendent.

Individuals seeking funds online may NOT:

Withdraw funds from the site into personal bank accounts. (Funds
should be requested from the site in the form of a check, made payable
to the District or Activity Fund.)

Transfer donations from campus to campus.
Ask for donated items to be mailed to the employee’s home.

Seek funding for personal reasons, individuals, or political reasons in the
District name.

Pressure parents to make donations.

CBISD, Rev. 8/8/2020
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Revenue Received

Sale vs. Not a Sale

A sale is the transfer of title or possession of tangible personal property for
consideration (usually money}. A sale also includes the performance of a
taxable service for consideration. Tangible, personal property includes
personal property that can be seen, weighed, measured, felt, touched or that is
perceptible to the senses in any manner.

All sales (whether taxable or not) must be reported on the Texas Sales Tax
Return. Bookkeepers are required to report all sales on a quarterly basis to
the district office.

Public schools and school-related organizations must collect sales tax on all
sales which are not specifically exempt.

In some fund-raising activities, the school or group is merely acting as a sales
representative for a retailer, and tax must be collected. The tax would be
remitted to the retailer, and the retailer would claim it as their sale and would
pay the tax to the Comptroller. The school would NOT report this type of
activity as a sale. Examples are vending machines, school pictures, and book
sales. Only when the school group purchases the merchandise and then
resells these items to their customers is the school the seller. The school
should provide a resale certificate to the retailer.

Sale Not a Sale
Admission — Athletics, dances, drama Collection of money from
performances. students to pay a company

for admission. (i.e. Theaters,
PSAT test, Theme Parks, Field
Admission - summer camps, clinics trips.
workshops, project graduation.

Donated Items that are sold. Donations of money to the group
for a commemorative brick, etc
Fundraisers where we are the seller

and not just the middle people. Dues received for clubs.

Rental of items. Fees — musical instr, Maint.,
Lab, uniform cleaning,

Rental of facilities transcripts, lockers.
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Sale Not a Sale

Library books, parking fees, Fines received — textbooks,
locker, calculator obligations
Sales of merchandise.
(including items made by students)
Fundraisers when the group

Sales of services. Merely receives a commission.
(book fairs, recycling, etc.)

School publication sales. Marathon fundraisers — these
Are donations.

Sales of food. Summer school, Community

Education tuition & fees.

Taxable Sales vs. Non-Taxable Sales

Texas sales tax statutes impose tax on the sale, lease, or rental of tangible
personal property and selected services. When an individual purchases a
tangible item and it becomes their personal property, it is taxable.

School districts and school-related organizations must collect sales tax on all
sales which are not specifically exempt. The following tables outline various
situations.

Tax Exempt Sales

The following are automatically exempt from sales tax.

Ad sales — in yearbooks, athletic programs, newspapers, posters
Admission — athletic events, dances, musical and drama performances.
Admission — summer camps, clinics, workshops, project graduation
Admission — banquet fees

Admission — prom, homecoming

Admission - tournament fees, academic competition fees
Cosmetology Services — (Products sold to customers are taxable)
Discount/Entertainment cards and books

Facility rentals for school groups.

Food items sold during fundraisers.

Labor — automotive, technical classes (parts are taxable)

Magazine subscriptions greater than six months

Parking permits.

Services — car washes, cleaning

CBISD, Rev. 8/8/2020
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TAXABLE SALES

Agenda books

Magazines - subscriptions less than 6 mo.

Agricultural sales

Magazines - when sold individually

Art - Supplies, and works of art

Musical supplies - recorders, reeds

Artistic - CD's, tapes, videos

Parts - career & technology classes (not to
include products used in cosmetology)

Athletic - equipment and uniforms

Parts - upholstery

Auction items sold

PE - uniforms, supplies

Automotive - parts and supplies

Pennants

Band - equipment, supplies, patches,
badges, uniform sales or rentals

Pictures - school, group (if school is seller)

Book covers

Plants - holiday greenery & poinsettias

Books - workbooks, vocabulary, library,
author (when we are the seller)

Rentals - equipment of any kind

Brochure items

Rentals - uniforms of any kind, towels

Calculators

Repairs to tangible personal property (i.e.
computer repair, house remodeling)

Calendars

Rings & other school jewelry

Candles

Rummage, yard, and garage sales

Car - painting, pin striping

Safety supplies

Clothing - school, club, class, spirit

School publications - athletic programs,

Computer - supplies, mouse pads

School publications - posters,brochures

Cosmetology products sold to customers

School publications - magazines (unless >
six month subscriptions)

Cups - glass, plastic, paper

School publications - newsletters,
newspapers _(_generally are not sold though)

Decals

School publications - reading books

Directories - student, faculty

School publications - sheet music, hymnals

Drafting - supplies

School publications - yearbooks

Family and Consumer Science -
supplies and sewing kits

School store - all items (except food)

Fees - copies, printing, laminating

Science - kits, boards, supplies

Flowers - roses, carnations, arrangements Spirit Items
Greeting Cards Stadium seats
Handicrafts Stationery

Horticulture items

Supplies - any sold to students

Hygiene supplies

Uniforms - any type to include PE, dance,
drill, cheerleaders, athletic, club shirts.

Identification cards - when they are
sold to entire student body(not for a lost card)

Vending - pencils & other non-edible
supplies when the school services machine.

Locks - sales and rentals

Woodworking crafts - entire sale to
include parts & labor

Lumber

Yard ﬂ\s

Merchandise, tangible personal property
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Tax-Free Days

s Each bona-fide account is permitted TWO (2) one-day, tax-free sales per
CALENDAR year. During these tax-free sales, the organization may sell
any taxable item, tax-free.

¢ A bona-fide chapter is a group that must be organized for some business
or activity other than instruction or a participatory group. Essentially,
any student group that is recognized by the school and is organized by
electing officers (not just participatory captains), holding meetings, and
conducting business are bona-fide chapters of the school. Groups
meeting for classroom instruction or team sports are not categorized as
bona-fide chapters and do not qualify for the tax-free day sales.

For example:

The school district qualifies for a tax-free day.

The school-wide fundraiser qualifies for a tax-free day.

The Basketball Club qualifies, but the basketball team does
not.

The Cheerleader Club qualifies, but not the cheerleader team.
The Debate Club qualifies, but debates teams do not.

The French Club qualifies, but the French classes do not.
The Senior Class qualifies, but not one particular class that
has seniors in it.

R N N

e Each bona-fide group must have a listing of officers, Purpose Statement,
and an acknowledgement that decisions are made by the student
members on file with the Principal.

e Sales must be conducted within a 24-hour period. If items are pre-sold,
such as yearbooks, then delivery must take place within a 24-hour
period. Items sold after the completion of the one-day event are taxable.

¢ When the school or group receives a commission, the tax-free day sale
provisions do not apply because “the sale” is the vendor’s sale, not the
school’s sale. The school group would collect and remit tax to the
vendor, and the vendor must report the sale and remit tax to the
Comptroller’s office.

Food Sales

Food sales, including meals, soft drinks, candy, baked goods, etc., are exempt
from sales tax if sold by an organized group, are part of a fund-raising drive,
and all proceeds go to the organization for its exclusive use. Student groups,
PTAs, and booster clubs are also included. It does not matter if the sale is
during the school day, the evening, or on a weekend; if it is a fund-raiser, it is
not taxable.

e = = T — |
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Raffles

Raffles are NOT allowed by Campuses, Activity Fund Clubs or Organizations.
According to Columbia-Brazoria ISD’S Policy CDC(LEGAL), the district is not a
“qualified nonprofit organization” for purposes of the Charitable Raffle Enabling
Act and shall not sponsor or conduct raffles, i.e., award one or more prizes by
chance at a single occasion among a pool or group of persons who have paid or
promised a thing of value for a ticket that represents a chance to win a prize.” It
is also against the law for Booster Clubs, PTOs, or Project Graduation to
conduct a raffle unless that organization has been a Qualified 501C3 Org. for 3
years according to the Texas Attorney General’s Office.

Auctions

Auctions are allowed, however, unless you are a qualified group and this is one
of your tax-free sales, the proceeds from an auction are taxable.

Donations

The Business Office MUST be notified of ALL Donations Received and Grant
Funds applied for and received. Please send the documentation to the
Executive Director of Financial Services. The Chief Financial Officer will make
the determination whether the funds go into the General Fund Budget or
Activity Funds.

Fundraiser/Non-sale

It is possible to have a Fundraiser that is NOT a sale. For example, Marathons,
Hit-a-thons, Fun Runs, and Book Fairs or Merchandise Sales when we only
receive a commission. These need to be classified as “Fundraiser-Nonsale”.

Collecting and Depositing Funds

1. All money (cash and checks) collected must be deposited to the school’s
activity fund bank account. Cash collected may not be used to make
purchases or payments of any kind. All payments from the activity fund
must be made with a check from the bank account.

2. All money collected must be deposited in the same form as collected. A
personal check may not be substituted for cash collected. NO personal
checks are to be cashed from funds collected.

3. No personal checks over $300 should be accepted for fund raisers. All
personal checks accepted must include a Drivers License and telephone
number, and physical address.

4. For control purposes, there should be at least two people involved in the
collecting and depositing of funds. Sponsors are responsible for

CBISD, Rev. 8/8/2020
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collecting, counting, and turning in all funds to the school secretary.

The school secretary is responsible for verifying the count, giving the
Sponsor a receipt, and depositing the funds to the bank.

Sponsors are not to take money home or keep it unsecured in the
classroom. Large collections should be deposited with the school
secretary each day. In the event a sponsor cannot prepare the funds for
deposit, the money should be counted by the sponsor, secured in a bank
bag, and given to the school secretary to store in the vault until a deposit
can be made. Sponsors should not hold more than $50 longer than
overnight, and no funds should be held past the Friday of each
week.

The school secretary may want to establish set times for turning in funds
collected. All funds should be properly receipted and counted as
described below.

Receipting Funds Collected

1.

2.

The sponsor must provide a receipt for all funds that are received for the
activity fund. Receipts should be prepared as the funds are received.

All receipts must be written in ink, with any corrections noted with a line
through the error and initialed by the person making the correction.

. One of the following receipt forms should be used by the sponsor. Each

form is designed to accommodate different situations. The sponsor
should keep a copy of each receipt form turned in to the
school secretary.

. The Multiple Receipt Record may be used by the sponsor when

receiving small amounts from multiple individuals for the same purpose.
The sponsor will list each person/student who paid, date, and amount
where indicated. Before delivery to the school secretary, the sponsor
should total the funds received, and verify that the counted cash and
checks total the amount listed on the form.

The Sales Receipt Form may be used by the sponsor when collecting
money for activities when it is not feasible to list each individual payee.
These events may include sales of items at a table such as T-shirts,
tickets to an event, school store, book fair, etc. Before delivery to the
School Secretary, the sponsor will list the date, items sold, and total cash
collected, tally the funds received at the bottom of the form and verify
that the counted cash and checks total the amount listed on the form.
Individual Receipt Books may be used by sponsors for funds collected
individually, especially when they require a receipt for future reference.
Examples include: Yearbook sales, lost textbooks/library books

When Individual Receipt Books are used, the sponsor provides the
original receipt to the payee and retains one carbon copy in the receipt
book. When submitting funds to the School Secretary on the Multiple

CBISD, Rev. 8/8/2020
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Receipt Record, it is not necessary to list each individual receipt
separately; a listing of “Receipt# through # ” is okay. The
sponsor must verify that cash and checks turned in equal the total
receipts. Individual receipt books are to be turned in to the campus
secretary and the end of school year.

7. The Activity Fund Bookkeepers (School Secretaries) have been instructed

not to accept funds for deposit that have not properly been counted and
receipted by the Activity Fund Sponsors.

8. The School Secretary will count the deposit in front of the sponsor and

verify the totals, and then issue a receipt for funds turned in.

Purchases from Activity Funds

All purchases and payments from activity funds must be requested and
authorized in advance by using a Request for Payment form.

Campus Activity Funds (CAF) belong to the district, and therefore, must adhere

to State regulation and District policy regarding expenditures.

CAF Allowable Expenditures: (Direct or indirect benefit to students.)

Field Trips — Admission Fees

Perfect Attendance incentives for students. (limit of $50, no Gift Cards.
These are Tax Exempt.)

Teacher appreciation, gifts, awards, & incentives. (limit of $50, no Gift
Cards. These are Tax-Exempt)

Classroom and Office Supplies

Refreshments & Snacks (for in-service or staff meetings)

CAF Prohibited Expenditures:

Individual Membership fees.

Gifts over $50. {flowers, gift certificates, bonuses) Gifts of less than $50
may come from “Hospitality Funds” collected by the staff, & are tax
exempt.

Donations (Because these are District Funds)

Abuse of Staff Appreciation meals, parties for staff.

Extravagant expenditures.

Student Activity Funds (SAF) belong to various student groups, Clubs, or

Classes that have elected officers. The spending decisions rest “solely” with the
students. These funds are not subject to purchasing or bid laws, and it is
recommended that the Club President or Treasurer approve expenditures.
Donations are allowed.

CBISD, Rev. 8/8/2020
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Reimbursements

Reimbursements are allowed from Activity Funds ONLY with PRIOR
APPROVAL. Sponsors must submit a Request for Pre-Approval prior to
purchasing in order to be reimbursed for expenditures. The receipt/invoice
must also be submitted within 30 days of the purchase, or the reimbursement
will be denied. (See revised Requisition for Payment in Forms Section)

Reguest for Payment

1.

2.

The activity fund sponsor should complete the Request for Payment
Form and submit it to the School Secretary for administrative approval.
Invoices/receipts for payment to vendors must be submitted to the
School Secretary with the Request for Payment form in a timely manner.
Late payments to vendors reflect on the entire school district, and could
result in late payment fees or interest charged to the account.

The original vendor invoice or detailed receipt must be attached. Invoice
copies and vendor statements of the balance due are not acceptable
forms of documentation. In certain circumstances, a letter, renewal
notice, or contract form may be used when no invoice exists. The
principal must approve these alternate forms of documentation for the

payment.

. The School Secretary may not prepare a check without the Request for

Payment form and proper documentation from the sponsor. The
Principal must either sign the Request for Payment or the Check to
insure that the Administrator is aware of all expenditures made from
Activity Funds.

All payments from the Activity Fund must be made by a check prepared
by the School Secretary and signed by authorized personnel. NO
payments may be made from cash collected or received by the sponsor or
the School Secretary, and NO CHECKS should be made to CASH.

Each check should be manually signed and under NO circumstances
should checks be pre-signed. Checks must be written and signed at the
time they are needed and with proper documentation. All checks must
indicate the payee and the dollar amount before being signed. (NO
BLANK CHECKS.)

. The School Secretary will verify that sufficient funds are available in the

appropriate activity fund account before issuing a check.
Income received for a specific group should be spent for that group.

. Payments to district employees, other than reimbursements, must be

made through the CBISD Payroll Office. Payments should never be
made to employees from the activity fund for services rendered, extra-
duty or overtime.
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10.People or companies who are not district employees, and are paid for

services provided to an activity fund must be identified as contractors.
Payments to contractors and/or sole proprietors will be reported to the
IRS, and a Form 1099 will be issued to the contractor for any amounts
equal to or greater than $600.00. An IRS Form W-9 indicating the tax-
payer ID must be on file with the School Secretary or the District Office
before a contractor can be paid. Expenditures classified as “Contracted
Services” include:

Catering/banquet services

Repairs: machinery, uniforms, mats, etc.

Business Services including printing, landscaping, etc.

Rentals: cars, vans, buses, costumes, facilities, etc.
Presenters/Performers (disc jockeys, seminar and workshop
speakers, dance clinic assistants, etc.)

Custom services: monogramming, sewing, choreography, custom
T-shirts, etc.

< L L L L L

PLEASE SEE ADDITIONAL INFORMATION ON VENDORS & THE IRS IN THE
“ADDITIONS” SECTION, DATED JAN. 2013.

Sales Tax Exemptions on District Purchases

11.

12,

13.

14,

Federal Statutes provide tax exemptions to the school district.

School Districts are entitled to an exemption only on items

purchased and used directly for the educational process.

The Texas Sales Tax and Use Tax Exemption Certificate must be
presented each time a purchase is made. The certificate must state
that the merchandise being purchased is for the organization’s own

use in providing education, is being made in the name of the
organization and that payment will be made from the organization’s own
funds. These are available thru the District Office.

Purchases made by individual members, teachers, or coaches, for
personal use do not have exemption from sales tax even though they are
connected with the school or a school organization. These items might
include cheerleaders purchasing their own uniforms, science

students purchasing a science board, or athletic team members
purchasing their own jackets or gear. You can elect to pay

the sales tax up front on the Vendor Invoice (Preferred Method) or have the

District pay the Sales Tax at the end of each quarter.

(The payments from students should be categorized as Sales Non-Taxable
if the tax is paid upfront to the Vendor, and Hospitality Flowers and Gifts
less than $50 are considered Tax Exempt.)

Sales tax for meals is exempt only if the school contracts for the

meal and the meal is paid for by the school.

— T T T R —
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15. School districts are exempt from the state portion of the hotel tax. A
Texas Hotel Occupancy Tax Exemption Certificate must be
submitted to the hotel. We are required to pay local taxes.

16. Booster Clubs, PTAs, and other associated groups may not use the
district’s tax exemption certificate or employer identification
number. By law, these groups must obtain their own tax exemption
status and employer identification number.

Change Funds

Change funds may be set up for special events or activities as follows:

1. The sponsor will complete a Request for Payment form indicating the
amount of change needed and the denominations. The form should
include a description of the event for which the change is needed, the
date, and duration.

2. The School Secretary will prepare a check and take it to the bank to get
the change. The School Secretary should request a change slip from the
bank indicating the amount of change received and the denominations.
The change slip should be attached to the Request for Payment form as
documentation.

3. The exact amount of the change fund must be returned to the School
Secretary immediately following the event or at the beginning of the next
work day.

Transfers

Occasionally a club will compensate another school organization for goods
purchased or services performed. This may occur when a club purchases
advertising in the yearbook, newspaper, etc. A transfer of funds shall be made
between accounts in such instances instead of issuing an Activity Fund Check.

A Club might also desire {and vote) to make a voluntary donation or
contribution to partially defray the expense incurred by another club. In such
cases, the contribution shall be initiated by a transfer of funds in lieu of an
Activity Fund check being issued.

1. A Request for Transfer form is completed and signed by the sponsor of
the Activity Fund Account for which the funds are being deducted. The
sponsor who will receive the funds must also sign the form.

2. They then submit the form to the School Secretary, who must obtain the
Principal’s approval.

3. Once approval has been given, the School Secretary will record the
transfer, and return a copy of the approved Request for Transfer to each

CBISD, Rev. 8/8/2020
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sponsor. (SEE QUICKEN INSTRUCTIONS FOR RECORDING
TRANSFERS)

4. Both sponsors will record the transfer in their records, and update their
balances.

Record Keeping

1. Sponsors will maintain a binder with receipts and expenditure records
in chronological order.

2. Everything that affects the account must be recorded and accounted for,
and a running balance computed as each transaction is entered.

3. At the end of the month, the School Secretary should provide each
sponsor with a computer report. This report should show the beginning
balance of the account, transactions posted that month, and the ending
balance.

4. Sponsors should reconcile the account by comparing each transaction
entered to those posted on the computer report.

5. The School Secretary should be consulted if assistance is needed, or if
there are unexplained discrepancies.

Activity Fund Audits

Activity Funds will be audited on a regular basis by the district’s independent
auditors and by the district Business staff. All records of the sponsors and
School Secretaries are subject to audit and must be made available upon
request.

CBISD, Rev. 8/8/2020
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Information for School Secretaries

The School Principal is responsible for the proper collection, disbursement, and
control of all activity fund monies. These responsibilities include:

4,

5.

1. Providing for the safe-keeping of monies.
2.
3. Expenditure of funds in compliance with applicable state laws, and local

Proper accounting and administration of fund transactions.

board policy administrative guidelines.

Adequate training and supervision of all personnel (generally the School
Secretary) designated to administer activity funds.

Keep a schedule on the tax-free fundraiser dates for student groups.
There are only (2) per year.

The principal is not responsible for funds collected, disbursed and controlled
by parent or booster organizations. These groups are not to be accounted for
in the school’s activity funds.

Basic Records

Authorizations to Conduct a Fund Raiser

These forms are used by the Activity Fund Sponsors to request pre-approval for
all fund raisers.

The Sponsor completes the top portion of the form and submits it to the
Principal for approval.

The School Secretary sends the original to the Superintendent’s Office for
approval, and logs the fund raiser onto the Fund Raiser Log/Calendar.
The Superintendent’s office will return the approved /denied form to the
Principal’s Office and the Secretary will forward the signed original to the
Sponsor. The School Secretary retains a copy.

Once the fundraiser is complete, the Sponsor and Club Treasurer shall
sign the original, complete the bottom portion, and return to the School
Secretary to file.

The School Secretary should compare the accounting records to the form
submitted by the sponsor to verify that both records match.

At the end of the month the School Secretary should provide each
sponsor with a computer report showing transactions for the month, and
the ending balance. It is the responsibility of the sponsor to review this
report and discuss any discrepancies to the School Secretary.

CBISD, Rev. 8/8,/2020

Page 17



Sales Tax Issues — Quarterly Sales Report

All sales (whether taxable or not) must be reported on the Texas Sale Tax
Return., The School Secretaries are required to report all sales on a quarterly
basis to the district office.

Please see the Section on Revenue Received in the Sponsors Handbook with
regards to Sales vs. Non-sales and Tax Issues, pgs. 6-8.

Sponsors are required to designate on the Authorization to Conduct a Fund
Raiser form whether it is a Taxable sale, Non-taxable sale, or a Non-sale.
Secretaries should review these for proper designation.

School Secretaries are required to keep records on the total sales for the
quarter along with a record of each Activity Fund’s “Free-Tax” Sales. The
Campus Sales Log should help facilitate this.

At the end of a quarter, the School Secretary should print a report from
Quicken.

¢ Click on Reports/Spending/Itemized Categories.

» Customize the Categories by selecting Sales/Non-taxable, or
Sales/Taxable Income. (It might be easier to print separate reports for
each category.)

¢ Expand All, to show detail.

¢ Customize the Report by changing the title to “Sales Tax Report”.
OK/SAVE

e Sort by Date (Customize the date range depending on the beginning and
ending dates of the quarter.)

e Sub-Total by Tag.

The total Taxable Sales and Non-taxable sales should then be reported to
the Business Office by the 1t monthly check-write documentation
deadline date. State Sales Tax reports are due to the Comptroller by the 18th
of the month.

Bank Reconciliations — Month-End Reports

Campus Secretaries are responsible for reconciling the Activity Fund to the
Bank Statement monthly. Bank Statements may be retrieved via Prosperity
Bank online the 1st of every month.

-CB[SD, Rev. 8/8/2020-
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Please submit to the Business Office prior to the 10t of each month the
following;:

¢ Quicken Reconciliation (see Basic Quicken Instructions)

e A Register Report which will include all transactions from the beginning
of the fiscal year, subtotaled by Tag. The total of this report should equal
the total reconciled register balance.

A copy of the Bank Statement.
An Income/Expense Report for the month.

Receipting Funds Turned in by Sponsors

The School Secretary should count all funds turned in from Activity Fund
Account Sponsors in the presence of the sponsor, or the person turning in the
funds, at the time the funds and receipt forms are turned in. Any discrepancy
should be resolved at that time.

(It is helpful to note the Activity Fund Account Number on the receipt at this
time to later facilitate in posting.)

Only pre-numbered cash receipts should be used. Triplicate receipts are
recommended. Original back to the sponsor, Duplicate attached to the
validated deposit slip and filed with each Activity Fund’s records, and the
Triplicate copy to remain in the book. It is the responsibility of The School to
purchase pre-numbered receipt books, or to have them printed.

The School Secretary may want to establish certain times/days during the
week for turn-in.

Deposits

The bank deposit slip should be completed by the School Secretary listing cash
amounts and checks.

o All checks should be properly endorsed by your school’s Activity Fund
Stamp.
Activity Fund account number should be listed on the deposit slip.

e Deposits should be made in a timely manner. All funds shall be
deposited by Friday of each week.

e Any cash on hand, not completed for deposit, should be held in the
school safe until the deposit can be made.

e The validated deposit slip should be filed along with the receipt forms
with each Activity Fund’s records.

CBISD, Rev. 8/8/2020
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¢ Please MAKE A COPY of all DONATION Checks, or any Checks Deposited
when there is not additional information to attach to the Deposit Slip.
Every Deposit should have some form of backup documentation.

¢ See Quicken Instructions for specifics on Recording Transactions in

Quicken.

Checks Written

All expenditures shall be paid by a pre-numbered check from the Activity Fund
checking account. NO payments should be made from cash collected or
received by the sponsor or the School Secretary.

(The district office maintains a petty cash fund for expenditures not to exceed
$25.00 if necessary.)

Income received from a specific group should be expended for that group. The
principal shall ensure that expenditures from these accounts are written for
the intended purpose of the group.

NO expenditure of funds shall be approved by the principal unless sufficient
funds are available in the appropriate activity account, or unless funds are
anticipated at a later date.

ALL expenditures from Activity Funds require the approval of the Campus
Principal, either by signature on the Request for Payment, or actual
signing of the check.

Reimbursements

Reimbursements are allowed from Activity Funds ONLY with PRIOR
APPROVAL. Sponsors must submit a Request for Pre-Approval prior to
purchasing in order to be reimbursed for expenditures. The receipt/invoice
must also be submitted within 30 days of the purchase, or the reimbursement
will be denied. (See revised Requisition for Payment in Forms Section)

All purchases and payments from activity funds must be requested and
authorized in advance by using a Request for Payment form.

1. The activity fund sponsor should complete the Request for Payment
Form and submit it to the School Secretary for administrative approval.

2. The approved form will be returned to the sponsor, and then the
purchase can be made.

CBISD, Rev. 8/8/2020
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3. Invoices/receipts for payment to vendors must be submitted to the
School Secretary with the Request for Payment form in a timely manner.
Late payments to vendors reflect on the entire school district, and could
result in late payment fees or interest charged to the account.

4. The original vendor invoice or detailed receipt must be attached. Invoice
copies and vendor statements of the balance due are not acceptable
forms of documentation. In certain circumstances, a letter, renewal
notice, or contract form may be used when no invoice exists. The
principal must approve these alternate forms of documentation for the
payment.

5. The School Secretary may not prepare a check without the Request for
Payment form and proper documentation from the sponsor. In some
case an advance payment may be necessary for expenses incurred on an
out of town trip, etc. The settlement of all advances (i.e. proper
documentation) must be completed and turned in no later than fifteen
(15) days after the completion of the activity.

6. The School Secretary will verify that sufficient funds are available in the
appropriate activity fund account before issuing a check.

Please see additional, specific purchasing requirements such as payments to
district employees, sales tax issues, and hotel exemptions in the Sponsor’s
Handbook, Purchasing from Activity Funds, pg. 12.

Once a Request for Payment has been approved, the School Secretary may
prepare the check.

1. All Activity Fund checks must be manually signed by authorized check
signers. C.B.L.S.D. requires two (2) signatures. Each check should be
manually signed and under NO circumstances should checks be pre-
signed. Checks must be written and signed at the time they are needed
and with proper documentation. All checks must indicate the payee and
the dollar amount before being signed. (NO BLANK CHECKS.)

2. The use of Quicken compatible laser checks is recommended. When
printing from Quicken, the check is automatically posted to the system.
To purchase checks, go to the website, inuit.com, and purchase the
“Voucher Check” style of checks. An automatic draft from your Activity
Fund will be created. You may wish to divide the cost of checks among
the various activity funds.

3. The Check #, Check Date, and Amount are recorded on the Request for
Payment form.

4. The check is either returned to the appropriate Activity Fund Sponsor, or
mailed to the vendor with proper identification, such as order forms,
payment stubs, renewal forms, etc.




5. One check stub is attached to the Request for Payment, and is filed with

the attached documentation by fund. The 2nd stub is filed numerically.

See Quicken Instruction for specifics on Recording Transactions in

Quicken.

Change funds may be set up for special events or activities as follows:

The sponsor will complete a Request for Payment form indicating the
amount of change needed and the denominations. The form should
include a description of the event for which the change is needed, the
date, and duration.

Once approved, The School Secretary will prepare a check and take it to
the bank to get the change. The School Secretary should request a
change slip from the bank indicating the amount of change received and
the denominations. The change slip should be attached to the Request
for Payment form as documentation.

The exact amount of the change fund must be returned to the School
Secretary immediately following the event or at the beginning of the next
work day.

Transfers

Occasionally a club will compensate another school organization for goods
purchased or services performed. This may occur when a club purchases
advertising in the yearbook, newspaper, etc. A transfer of funds shall be made
between accounts in such instances instead of issuing an Activity Fund Check.

A Club may also desire (and vote) to make a voluntary donation or contribution
to partially defray the expense incurred by another club. In such cases, the
contribution shall be initiated by a transfer of funds in lieu of an Activity Fund
check being issued.

1. A Request for Transfer form is completed and signed by the sponsor of

the Activity Fund Account for which the funds are being deducted. The
sponsor who will receive the funds must also sign the form. They then
submit the form to the School Secretary, who must obtain the Principal’s
approval.

Once approval has been given, the School Secretary will record the
transfer, and return a copy of the approved Request for Transfer to each
SpOnsor.
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3. Both sponsors will record the transfer in their records, and update their

balances.

Returned Checks

C.B.1.S.D. has contracted with Envision Check Collection Services. Insufficient
Fund checks go directly to them for collection.

Please be advised that all personnel involved with the receipt of funds at your
campus should be aware of the collection program and the requirements.

For compliance with Federal and Local laws, the Envision Payment
Solutions Decals MUST be easily visible near the registers, entrances,
etc.

Required information on the check include: Name, Address, Phone
Number, TDL#, Signature, Date, and Amount.

DO NOT ACCEPT 274 Party Checks, 3™ Party Checks, Checks over $300,
Postdated Checks, or Non-imprinted checks.

DO NOT ACCEPT PAYMENTS for customers attempting to pay their
returned checks. Have them contact the District Office, 979-345-5147,
ext. 1119.

If, for any reason, Envision Solutions is not able to collect a returned check
from your campus, your campus will be responsible for reimbursing the
District. You will receive notice at the end of the school year.

Year End

Before the Fiscal Year ends on June 30t you should have done the following:

Paid any outstanding Student Transportation Charges.

Closed out the Pass-Thru Accounts, (Library, Textbooks, Calculators})
and sent an Activity Fund Check to the District Office for these amounts.
Made sure that there are NO negative balances for any club or account
by doing any necessary transfers.

Run your Payee Report for Jan-June. (for 1099 purposes)

Run Sales Tax Reports for the 2rd Qtr. and send a copy of the report to
the Business Office. (See Quicken Instructions)

At Year End you should do the following:

Reconcile your bank account.
Run all reports. {See Quicken Instructions.)
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e Close the year and role into the New. (See Quicken Instructions)
o Box up your records for the year and send them to the Business Office.

CBISD, Rev. 8/8/2020
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AUTHORIZATION TO CONDUCT A FUNDRAISER FORM

Please submit form to Campus Secretary. If the activity is approved then it will be placed on the
After Superintendent approval/denial you will receive a copy with all necessary signatures.

Campus: Date:

Activity Fund/Booster: Acct #:

Contact Name/email/phone:

FUNDRAISER INFORMATION:

Requested Dates : 1st Choice 2nd Choice

{circle one) TAXABLE SALE/NON-TAXABLE SALE/NOT A SALE/WE WILL PAY SALES TAX UPFRONT

MUST PROVIDE (3) QUOTES ({Please attach) and USE LOCAL VENDOR if possible.
Type of merchandise to be sold/Fundraiser Info.

On Campus Sale ONLY: Community/Campus Sale:

Funds generated will be used for:

Type of Merchandise to be sold:

Sponsor's Signature:

Principal's Signature:

APPROVE DISAPPROVE Superintendent Signature

Sponors: Please have an announcement made the week of the sale fo inform everyone of Fundraiser
Actual Sales:

Receipt # Amount Deposited Sales Tax {if applicable)
$ $
$ $
$ $
$ $
Total Deposits S Total Sales Tax  §
Actual Sales { Amount Dep.- Less Sales Tax) $
Actual Expense:
Invoice # Amount
S
$
$
Total Expense $
Net Profit/Loss (Total Sales less Total Expenses) ¢ $
Club Treasurer: Club Sponsor: Date:

It is the Sponsor's responsibiltiy to complete form w/in 30 days of final sale and return to the Campus Secretary.

8/8/2020



Authorization to Conduct a Fundraiser Form - INSTRUCTIONS

1.

This form is used to request pre-approval for all fundraisers, provide for
placement on the school/district calendar, and provide an accounting
of the fundraising activity, including sales tax collected, and payable to
the state.

. The sponsor will complete the top portion and submit the form to the

principal, who will sign off, and forward a copy to the Superintendent’s
office for approval. A copy will be returned to the Principal, who, in
turn, should return the approved/denied form to the sponsor.

. The middle portion of the form will be used by the sponsor to keep

track of deposits and expenses related to the fundraiser that are
submitted to the Campus Secretary. Each deposit should be receipted
as described in the Activity Funds Manual.

. Once complete, the Club Treasurer and Club Sponsor should sign at

the bottom and forward a copy to the Campus Secretary.

. A copy of the final, completed form, should then be returned to the

Superintendent’s Office.



School:

MULTIPLE RECEIPT RECORD

Purpose: Documentation for monies collected from individual students in the SAF organization. The
SAF Sponsor may choose to submit their own record if all information is provided.
The Sponsor shall total, sign, and date the form. The money ¢ount box should be
completed. This form should be given to the School Secretary.

CSAF Account Number CSAF Account Name

Funds Collected for the Event of:

| NAME/RECEIPT # DATE AMOUNT | | NAME/RECEIPT # DATE AMOUNT |
1 16
2 17
3 18
4 19
5 20
6 21
7 22
8 23
9 24
10 25
11 26
12 27
13 28
14 29
15 30
TOTAL
Sponsor Signature Date
Money Count (to he completed by sponsor) Office Use Only
Checks Quarters Receipt Amount Number |Date
$100s Dimes $
$50s Nickels $
$20s Pennies $
$10s Other $
$5s8 $
$1s Total $ $

Columbia-Brazoria I.S.D.



School:

SALES RECEIPT FORM

Purpose: Documentation for monies collected where a Multiple Receipt Record is not feasible,
Examples include items sold at a table, school store sales, pre-numbered tickets, etc.
The Sponsor shall total, sign, and date the form. The money count box should be
completed. This form should be given to the School Secretary.

CSAF Account Number CSAF Account Name

Funds Collected for the Event of :

Item Sold # Sold Price per item Total $$ Collected
TOTAL $

Sponsor Signature Date

Money Count (to be completed by sponsor) Office Use Only

Checks Quarters Receipt Amount |NuyDate

$100s Dimes $

$50s Nickels $

$20s Pennies $

$10s Other $

$5s | $

$1s Total $ $

Columbia-Brazoria |.S.D.



REQUISITION FOR PAYMENT / REIMBURSEMENT FROM CAMPUS ACTIVITY FUND

{*Receipts for reimbursements MUST be submitted within 30 days of the Receipt date or the request
will be denied.)

To: Campus Principal Campus: DATE:

Request Pre-approval for Reimbursement for

Description of ltem

Purpose
Account Fund Name & Number: In the amount of $
Signature of Sponsor:
Signature of Supervisor: D Approve[l Deny

e s

Check Write
To: Campus Secretary/Activity Fund Coordinator DATE:
Pay to the order of in the amount of $
Dollars
Activity Fund Name Account #

Description of Item

Purpose

Check one { ) Returnto Sponsor ()} Mail Check to Vendor

Signature of Treasurer Signature of Sponsor

B B o O B e g

For Campus Secretary only:

Date Paid : Check #

Campus Secretary Signature

Columbia-Brazoria !.S.D. 3/19/15



CAMPUS SALES LOG
(For Tax-Free Day Sales)

e,

School:
Calendar Year:

SAF SAF ITEMS TO DATES OF TAX FREE DAY SALE
ACCOUNT NUMBER |ACCOUNT NAME _ BE SOLD #1 | #2
Taxable sales: School purchased supplies sold directly to students including athletic, music &

{May be eligible PE equip. and uniforms. Yearbooks.

for two tax-free Fees for materials when the end product becomes a personal possession.
day salesin a Spirit items, incl. uniforms & shirts. School supplies. Custom items.
calendar year,) Any tangible item that becomes the property of the student or other individual,

EACH CLUB/ORG. IS CONSIDERED A SEPARATE EXEMPT ENTITY.
EACH BONA FIDE GROUP MAY HOLD TWO TAX-FREE DAY SALES EACH CALENDAR YEAR.
SEE MANUAL FOR DETAILS ON TAX-FREE DAY SALES.

Columbia-Brazoria 1.8.D.



SAF/CAF INTERFUND TRANSFER FORM
: School:

This form should be used instead of requisitioning a check when money is requested to be
transferred from one activity fund to another. BOTH activity fund sponsors must give approval,
along with the principal.

Transfer requested
I From: I
SAF/CAF Account Name and Number
] To: in the amount of § 1
SAF/SAF Acct. Name and Number

Reason for Transfer: _ _ .
Approved: ] v _ Date: .
Signature of DONER SAF/CAF Sponsor
Date:
Signature of RECEIVING SAF/CAF Sponsor
Date:

Signature of Principal

SAF/CAF INTERFUND TRANSFER FORM
School:

This form should be used instead of requisitioning a check when money is requested to be
transferred from one activity fund to another. BOTH activity fund sponsors must give approval,
along with the principal.

Transfer requested
| From: ]
SAF/CAF Account Name and Number

| To: in the amount of $
SAF/SAF Acct. Name and Number

I

Reason for Transfer:

Approved: Date:
Signature of DONER SAF/CAF Sponsor
Date:
Signature of RECEIVING SAF/CAF Sponsor
Date:

Signature of Principal

Columbia Brazoria [.S.D. 8/1/06



CBISD Fund Raising Checklist 2020

1. Plan your sale/event.

a. What is the purpose of your sale or fundraiser? What will the funds
be used for?

b. Is this a sale or non-sale? (see pg. 6 of Activity Fund Manual)
¢. Ifthis is a sale, is it taxable or non-taxable? (see pgs. 7 & 8)
—___d. For ataxable sale, will we pay the sales tax upfront to the vendor, or add
the sales tax amount to the price of our item and have the district pay the

sales tax from our Activity Fund Account?

e. If you are a Student Group Activity Fund, do you qualify for a Tax-Free Sale?
(pg. 9)

____2. Select a reputable Vendor, utilizing our Local Sources as best as possible.
3. Determine dates for the sale/event. A start date AND ending date.
4. Complete the Authorization to Conduct a Fund Raiser at least 2 weeks prior to the
start of your event, and submit to your Principal. DO NOT proceed with your Fund
Raiser until you have received approval from the Superintendent.
Once Approved
5. Order any necessary materials from the vendor.

6. Advertise your event.

7. Conduct your event. (**Reminder - NO DOOR TO DOOR SOLICITATION!)

As Funds are Collected
____8. Have a receipting procedure in place to record all funds collected. (pg.11)
a. Receipt funds from students turned in.

_—b. Deposit funds with School Secretary at least by Friday morning of each week,
with a detailed accounting of the total amount being turned in.



CBISD Fund Raising Checklist 2020

REMINDERS:

¢ All cash & checks collected MUST be deposited. Cash collected cannot
be used to make purchases or payments of any kind. NO personal
checks are to be cashed from funds collected.
No personal checks over $300.
Checks must include TDL#, phone #, and physical address.
DO NOT hold more than $50 in your room overnight,

—¢. Obtain a receipt from the School Secretary for any funds turn in.

9. Pay the Vendor in a timely manner.

a. Submit a Request for Payment with attached Invoice to the School
Secretary. (Must have sufficient funds in your account.)

____b. Mail the check

After the Event

10. Complete the bottom portion of the Authorization to Conduct a Fundraiser
Form and submit the completed form to your Campus Secretary.

Reminders about Tax-Exempt Purchases with Activity Funds

e The District is entitled to a tax exemption only on items purchased and used
directly for the educational process and for the benefit of the School as a whole.

¢ Purchases made for individual use DO NOT have an exemption from sales tax even
though they have a connection with the school. (ie. Gifts, band supplies, or uniforms
that become the personal property of the student.)



Quicken

Instructions for Activity
Funds
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Basic Quicken Instructions for Activity Funds

The following instructions are “Basic” for Activity Funds in Quicken for Columbia-
Brazoria I.S.D. For more detailed instructions, and additional help, please use the HELP
menu included in the program. The manual can also be downloaded by going to the
Intuit website at www.intuit.com.

1. Checking Account,

e Look at the Cash Flow Center on the left side of your screen.
e Double click on your school name. This is your checking account register.

2. Categories

Categories are your Income and Expense Accounts.
To find a list of these click on the Tools Tab, and Category on the drop down.
(See the Standard Category List at the end of this section.)

¢ To add new Categories/Accounts click the “New” button at the bottom of the
screen and add. Be sure to classify as income or expense.

e To edit an account to fit your specific school, place your cursor on the account

you wish to edit and right click. A drop-down list will appear, choose Edit, and
make your changes.

Addtl. Information on recording transactions in Quicken

Each transaction recording in Quicken will need to be “Tagged” (Club,
Group, Pass-Thru, etc.) and “Categorized” (Expense or Income).

Categories

There is a standard Category List at the end of this manual. Please make
every attempt to use one of the standard categories, however, in some
rare circumstances it may be necessary to create an additional category.
Please be as specific as possible and avoid using Miscellaneous too often.

For Fundraising Income you have (4) Choices:

e Fundraiser - Non-Sales (Things like Fun runs, Marathons, Turkey
feathers, and Book Fairs where we receive a commission, etc.)

e Sales - Taxable

» Sales - Non Taxable {food sales, service oriented sales, ticket sales
to an event and tax-free sales by a qualified group)

Columbia Brazoria ISD 1 Rev. 8/8/2020



¢ Commissions — (Coke & Vending machines, School Pictures)

Fundraising Expense - should be used when paying the fundraising
Vendors, or for buying supplies used for your fundraiser. DO NOT use
Fundraising Expense when spending your profits.

T-Shirt & Uniform Purchases (Those NOT turned in at the end of the
season, and considered personal.)

VERY IMPORTANT: Unless this is a Tax-Free Sale by a Qualified Group,
you MUST PAY SALES TAX. You can either pay the sales tax up front to
the vendor, or Categorize as a “Taxable Purchase” and let the District pay
the sales tax at the end of the Quarter. (the preferred method is to
always pay the sales tax up front, then no one has to worry about it!)

Here are a few examples:

1. If this is a Fundraiser and it qualifies as a tax-free sale, Categorize
the income as “Sales-Nontaxable”. Categorize the payment to the
vendor as “Fundraising Expense”.

2. If this is a Fundraiser that DOES NOT qualify as a tax-free sale,
Categorize the income as “Sales-Taxable. (If you did not pay the
sales tax upfront) If the taxes were included on the invoice and
paid, then the expense category is “Fundraising Expense”.

3. If the purchase is NOT a Fundraiser and you are just collecting
money for T-Shirts to be distributed to members, PLEASE PAY
THE SALES TAX UPFRONT! Categorize the Income as “Dues” and
the Expense as “T-Shirts”. However, if you do not pay the sales tax
upfront, then you will need to create the category “Taxable
Purchase”. You will also need to include this Category when
completing your Quarterly Sales Tax Reports

3. Tags

¢ Each Activity Fund Group/Club will be a TAG.

e To find a list of these, click on the Tools Tab, and TAG List on the
dropdown. There is an Activity Fund Account List provided.
Please use these standard account numbers, If you wish to add an
account, please let the business office know and they will assign
an available account number.

¢ To add, edit, or delete a Tag, click on the appropriate tab. The
system will not allow you to delete a Tag if transactions have
occurred for that Tag. (For smaller schools, you may want to
delete most of the funds showing, and leave only the ones specific
to your school.}

Columbia Brazoria ISD 2 Rev. 8/8/2020



To Enter a Deposit
In the Check Register:

Enter the date, or hit TAB if correct.

From the Drop-down menu choose, Deposit > TAB

Type the word DEPOSIT & a description in the Payee space > TAB
Enter the Amount > TAB

Select a Category (Income Account)

Enter the TAG Account> TAB

Type a Memo if needed > TAB

Hit SAVE.

To SPLIT the Deposit between more than one Activity Fund:

o Hit the SPLIT key in the Categories Column and a chart will come up. Use a
separate line for each Category/Tag (Activity Fund) to enter an amount for that
Fund. Repeat until you have allocated to all the necessary funds. When you are
done, the sum of the categories/Tags should equal the total deposit amount.

To Enter a Check

In the check register, Enter a date > TAB

Enter a Check number unless you are printing from Quicken. (in that case, enter
PRINT from the drop-down list) > TAB

o Enter the Payee > TAB, and Amount > TAB
[ ]

In the Category field, select a category (Expense account) from the drop-down
menu. > TAB

Add a TAG(Activity Fund Account) A drop-down list will appear. > TAB
Type a memo if necessary.
Hit the SAVE key to save the transaction.

To Split Categories:

¢ If you have a check that needs to be split between more than one Expense
Account OR more than one Activity Fund, use the SPLIT button. Enter an
amount for each Category/Tag until all funds have been allocated. The sum of the
category amounts should equal the total check.

OR (to write & print multiple checks)
SELECT Account Actions/Write Checks, in the Register. A Check form will pop up and

you can continue to enter a group of checks. Then you can Print then all at once. Make
sure to enter the correct beginning check number from your check stock.
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To Print a Single Check:

Click on the 3 More Actions button on the right side of the the transaction.
View Check.

Print. (Make sure you have the check number entered and the print set-up correct.

Record a Transfer OUT (Approval Needed)

In the Check Register:

Enter Date > TAB

In the “Check #’ Column, Enter Tnfr. > TAB

Payee Column, Type the description >TAB (Transfer To Choir)

Payment Column, Enter Amount > TAB

Leave the Category Section blank

Tag, Select the Account the Transfer is coming FROM when a box appears >TAB
Memo, Type “Transfer to (Activity Fund Account Name) > TAB (Transfer to
Choir for Robes)

SAVE

Record a Transfer IN (Approval Needed)

In the Check Register:

Enter Date > TAB

In the “Check #” Column, Enter Tnfr. > TAB

Payee Column, Type the description >TAB (Transfer from Soar)
Deposit Column, Enter Amount > TAB

Leave Category Section blank

Tag Section, Select the Acct the Transfer is going T.O >TAB

Memo Section, Type “Transfer from (Activity Fund Account Name) > TAB
(Transfer from Soar for Robes)

SAVE

To get a BALANCE HISTORY for a particular CAF or SAF

Select TAG List from the Tools drop-down list.

Click on the REPORT icon 1 to the left of the TAG you a report for.

You can get reports by month, Quarter, Year, Etc. by selecting a date range.
You can Customize your report depending on your particular needs.
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To get a MONTHLY REGISTER/TAG REPORT

¢ Select the Reports button at the top of the Register.

¢ Select Banking. Transaction. Include all dates (always run the report from the
date of your latest outstanding check, even if it falls in a prior fiscal year.} and
Subtotal by TAG. The total of this report should equal ending balance of your
check register and your reconciled bank balance at month’s end, and give you a
balance for each TAG.

HINT: You can adjust the report on the display tab by selecting items to show in the

column box. It is not necessary for the monthly reports to show the Account or CLR

Columns. You can also adjust the width of the columns by dragging the edges of the
columns at the top; making it easier to read with full descriptions, memos, and TAGS
showing.

Reconciling your Bank Statement
Bank Statements can be downloaded from the Bank on the first day of the month.

In Quicken Click, TOOLS/ RECONCILE.

e Using your Bank Statement, check the opening balance on your statement against
the opening balance listed in Quicken. Enter the ending balance on your
statement in the place provided.

e Enter the Interest Earned and select the category “Interest Income” and select a

TAG to indicate which Activity Fund will be credited with the earned interest.

Click, OK.

Check off the transactions in the window that also appear on your statement.

Click, Finished if the difference in the lower-right corner is zero.

PRINT a full reconciliation report to submit to the Business Office.

Income/Expense Report

On the Reports Tab at the top of the page, select Banking — Cash Flow.
Enter the Month for reporting,

e Save and Change the Title to Income/Expense and your Campus/Dept. Name.
(example: Income/Expense Barrow)
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Beginning a New Year

Prior to beginning the new year you will need to complete the following:

¢ Reconcile the last month of the fiscal year (June).

e Make a disk backup of the old year. ( File>Back Up and Restore>Backup
Quicken File)

e Print a TAG Report for the Entire Fiscal Year. The total of this report should
equal your register balance at year end. ( July 1% 20XX — June 30% 20XX)
(In some instances, you will need to use a difference beginning date if you
had outstanding checks at the beginning of the year. )

e Print a TAG Report for the Entire Fiscal Year with ONLY the CLEARED
Transactions. (In the Tag Report, Hit Customize, Advanced, and then Click
ONLY the Reconciled Transactions Box.) This report will be used to enter
your Opening Balances for each TAG.

Go to File > File Operations > Year End Copy.

Select “I only want transactions in the current data file starting with the new fiscal
year date, ie. 7/1/10, Then click OK.

Archive file > Name this file (Quicken will maintain the original file name for the
New Year....the Old Year File will be archived and needs to be renamed.
Suggestions include CHSyearend10.)

Box will pop up........ *File Copied Successfully. Select *File for New Year.

A New Year will be created and the opening balance will be last year’s ending balance
minus any still outstanding transactions which Quicken will automatically put in the new
year register. The Opening Balance will NOT be sub-totaled by TAG. You will have to
manually do this by going into your register and altering the opening balance by using the
SPLIT function. Take the ending balances from your Year End TAG REPORT
(Reconciled Transactions Only) and add each amount as a separate deposit, with the
memo Balance Forward. When all have been entered, Adjust the total. The total should
balance to your original beginning deposit that Quicken generated. This amount plus any
outstanding transactions should be your total opening account balance. (The entered
balances may not match due to outstanding checks. As long as overall total matches bank
statement you are okay.)

(Run a TAG Report for the New Year before entering any new transactions to check your
balances.)
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Payee Report for 1099’s (Report is due first of January each year.)

People or companies who are not district employees, and are paid for services provided to
an activity fund must be identified as contractors. Payments to contractors, sole
proprietorships, and Limited Liability Partnerships must be reported to the IRS, and a
form 1099 issued for any amounts over $600.00. An IRS Form, W-9, indicating the tax-
payer ID must be on file with the School District before a contractor is paid. If you are
unsure, and this is a new vendor, please check with the District Office before paying.
Please email the Business Office Administration Assistant to let her know when any new
vendor will be used. She will mail them a W-9 Packet.

Expenditures classified as “Contracted Services” include:

Catering/banquet services

Repairs, machinery, uniforms, mat, etc.

Business Services including printing, landscaping, etc.

Rentals

Presenters, Performers (DJs, workshop speakers, dance clinicians, etc.)
Custom Services: monogramming, T-shirts, etc.

To prepare the Payee Report which details all vendors paid during the calendar
year:

In Quicken

Go to Reports, Spending, and Itemized Payees.
Customize, choosing the following date ranges: (July 1 of the current fiscal year,
through December 31 of the current fiscal year.) And (January 1, of the past
fiscal year through June 30 of the past fiscal year. You will need to go back into
your backup files for the previous fiscal year to pull this particular report.)

o Display Tab — Subtotal by Payee, Sort by Account/Date, Organization by

Income/Expense.

Category Tab — Mark All Expenses

TAGs Tab — Mark All

Payees — All

You should get an alphabetized listing of each vendor paid throughout that time

period listing the detail of each check written.

e EXPAND the report to get the detailed transactions.
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Quarterly Sales Tax Reports (also found on pg. 18 of Activity Funds
Manual)

At the end of each quarter you will need to submit the following report to the Business
Office. ALL SALES (whether taxable or non-taxable income) and all “Taxable
Purchases” must be reported to the Texas Comptroller quarterly, and sales tax paid as
due.

Please run reports for BOTH Sales — Nontaxable Income, and Sales — Taxable Income, as
well as a report for Taxable Purchases.

In Quicken

Click on Reports/Spending/Itemized Categories.

Customize the Categories by selecting (Sales — Nontaxable, or Sales — Taxable,
and Taxable Purchases) It is easier to do separate reports for each account.

Sort by Date. (Customize the date ranges depending on the quarter.)

Sub-Total by Class. (Expand)

Customize the Report by changing the Title to: Sales Tax Report/OK/SAVE.

Reminder: If you use Microsoft Outlook you can put reminders on your calendar at the
end of each quarter to remind you to run these reports.

You may also want to create an excel spreadsheet to calculate the amount of sales tax
owed by each “TAG” or Activity Fund Account.

Please submit these reports to the Business Office prior to the 1% Check Write Date
Deadline of the month. If you DO NOT HAVE any sales, or purchases to report, please
initial the blank report and say, “NO SALES”. Please DO NOT just submit a blank
report.
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Columbia-Brazoria ISD

020007
ACCOUNTING CFD
ACTIVITY FUNDS MANAGEMENT (LEGAL)

Discretionary Funds  The District shall adopt a policy governing the expenditure of local
funds from vending machines, rentals, gate receipts, or other local
sources of revenue over which the District has direct control.

A policy under this section must:

1. Require discretionary expenditures of local funds to be related
to the District's educational purpose and provide a
commensurate benefit to the District or its students; and

2. Meet the standards of Section 52, Article lll, Texas
Constitution, regarding expenditure of public funds.

Education Code 44.908

DATE ISSUED: 11/2/2009 1 of 1
UPDATE 86
CFD(LEGAL)-P



Columbia-Brazoria ISD
020907

ACCOUNTING CFD
ACTIVITY FUNDS MANAGEMENT {(LOCAL)
Fiduciary The Superintendent, principal, and sponsor, as applicable, shall be
Responsibility responsible for the proper administration of District and campus ac-
tivity funds and student activity funds in accordance with state law
and local policy, District-approved accounting practices and proce-
dures, and the TEA Financial Accountability System Resource
Guide.
Student Activity The Superintendent or designee shall ensure that student activity
Funds accounts are maintained to manage all class funds, organization
funds, and any other funds collected from students for a school-re-
lated purpose. The principal or designee shall issue receipts for all
funds prior to their deposit into the appropriate District account at
the District depository.
Student activity funds shall be included in the annual audit of the
District’s fiscal accounts. [See CFC]
Use and Funds collected by student groups shall be used only for purposes
Expenditure authorized by the organization or upon approval of the sponsor.

District and Campus
Activity Funds

Approval

Carryover Funds

The principal or designee shall approve all disbursements. All
funds raised by student organizations must be expended for the
benefit of the students.

The Superintendent shall establish regulations governing the ex-
penditure of District and campus activity funds generated from
vending machines, rentals, gate receipts, concessions, and other
local sources of revenue over which the District has direct control.
Funds generated from such sources shall be expended for the
benefit of the District or its students and shall be related to the Dis-
trict’s educational purpose.

Approval from the immediate supervisor or designee shall be ob-
tained prior to a disbursement being made to any employee, in-
cluding the principal.

All funds shall be left in the appropriate account and each sponsor-
ing group shall retain the carryover funds for the next fiscal year. If
an organization ceases to function or exist, the unexpended funds

of the organization shall be credited to the appropriate administra-

tive activity account.
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UPDATE 86
CFD(LOCAL)-A



CBISD Policy CFD (Local)

Funds collected by student groups shall be used only for purposes authorized
by the organization or upon approval of the sponsor. The principal or designee
shall approve all disbursements. All funds raised by student organizations
must be expended for the benefit of the students. The Superintendent shall
establish regulations governing the expenditure of District and campus activity
funds generated from vending machines, rentals, gate receipts, concessions,
and other local sources of revenue over which the District has direct control.
Funds generated from such sources shall be expended for the benefit of the
District or its students and shall be related to the District’s educational

purpose.

Guidelines for Use of Funds

Any funds generated by student related activities/services must be used for
student related purchases ONLY.

s Proceeds from parking permits, cell phone fines, student ID
replacement fees, student vending machines, student picture sales,
etc. can only be used for items that will benefit the students.

e A separate campus activity fund account, Student Support Services,
should be set up for these type miscellaneous funds at a very
minimum. If you want to set up a separate account for each type
service, you are encouraged to do so.

Any funds generated by staff related activities/services can be used for staff
related purchases.
e Proceeds from staff vending machines, staff contributions, etc.
¢ A separate campus activity fund account, Faculty Fund, should be set
up for these type staff funds.
¢ These funds can be used for periodic staff events, but NOT “working
lunches” for individual staff.
¢ These funds can never be used for cash gifts or gift cards

Any funds directly donated from community must be cleared through the
Business Office with the following information:

¢ Donor name

* Amount of donation

¢ Donor specified use of donation and/or campus intended use

The Business Office will designate if the donation goes to budget or activity
fund depending on the intended use. These funds should NEVER be used for
staff parties, meals or gifts. Once donations are accepted, they are district
funds and district guidelines must be followed.

CBISD, Rev. 8/2020 Page 1



Columbia-Brazoria I1SD
020907

STUDENT FUNDRAISING FJ
(LEGAL)

Food and Beverage Schools that participate in the National School Lunch Program un-

Fundraisers der 42 U.S.C. Section 1751, et seq., or the School Breakfast Pro-
gram under 42 U.S.C. Section 1773, may sell food and beverages
that do not meet nutritional standards outlined in 7 C.F.R. Parts
210 and 220 as part of a fundraiser, during the school day, for up to
six days per school year on each school campus, provided that no
specially exempted fundraiser foods or beverages may be sold in
competition with school meals in the food service area during the
meal service. 4 TAC 26.2 [See CO and FFA)
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Columbia-Brazoria ISD
020907

STUDENT FUNDRAISING FJ

DATE ISSUED: 2/6/2017
UPDATE 107
FJ(LOCAL)-A

(LOCAL)

Administrative regulations shall address student fundraising plans,
approval of fundraising activities, and any required reporting on
fundraisers by campus administrators.

With at least one employee managing each project, students repre-
senting their school or the District may participate in approved
fundraising to benefit the District or a nonschool, charitable organi-
zation. Participation shall be voluntary and shall be approved only
when the fundraising activity relates to the District's educational
mission.

Fundraising shall not be permitted during class time. [See EC]

Fundraising through sales of foods and beverages that could be
consumed during the school day shall meet the requirements for
competitive foods unless the District allows an exception from the
competitive food requirement, as permitted by state and federal
law. [See CO and FFA]

ADOPTED: 1of1



Columbia-Brazoria 1SD
020907

OTHER REVENUES CDC
GIFTS AND SOLICITATIONS (LEGAL)

Use of Donated A conveyance, devise, or bequest of property for the benefit of the

Property public schools, if not otherwise directed by the donor, vests the
property in a board or their successors as trustees for those to be
benefited by the donation. Funds or other property donated or the
income from the property may be spent by the trustees:

1. For any purpose designated by the donor that is in keeping
with the lawful purposes of the schools for the benefit of which
the donation was made; or

2. For any legal purpose if a specific purpose is not designated
by the donor.

Education Code 11.156

Charitable Raffles A district is not a “qualified nonprofit organization” for purposes of
the Charitable Raffle Enabling Act and shall not sponsor or conduct
raffles, i.e., award one or more prizes by chance at a single occa-
sion among a poo! or group of persons who have paid or promised
a thing of value for a ticket that represents a chance to win a prize.
Occupations Code 2002.001 et seq.; Atty. Gen. Op. JM-1176
(1990) [See also GKB]
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Columbia-Brazoria ISD

020907
OTHER REVENUES CDC
GIFTS AND SOLICITATIONS (LOCAL)
Note: For purposes of this policy, the terms “gift” and “dona-
tion” have the same meaning.
Unsolicited Gifts The Board delegates to the Superintendent the authority to accept

Authority to Accept unsolicited gifts on behalf of the District. However, any gift that the
potential donor has expressly made conditional upon the District’s
use for a specified purpose, or any gift of real property, shall re-
quire Board approval.

Once accepted, a gift becomes the sole property of the District.

Criteria for The District shall not accept any gift that would viclate or conflict
Acceptance with policies of or actions by the Board or with federal or state law.

Before the Superintendent accepts a gift or recommends ac-
ceptance of a gift to the Board, as applicable, the Superintendent
shall consider whether the gift:

1. Has a purpose consistent with the District’s educational phi-
losophy, goals, and objectives;

2. Places any restrictions on a campus or District program;

3.  Would support a program that the Board may be unable or
unwilling to continue when the donation of funds is exhausted,;

Would result in ancillary or ongoing costs for the District;
Requires employment of additional personnel;

Requires or implies the endorsement of a specific business or
product [see GKB for advertising opportunities];

7.  Would result in inequitable funding, equipment, or resources
among District schools or programs;

8. Obligates the District or a campus to engage in specific ac-
tions; or

9.  Affects the physical structure of a building or would require
extensive maintenance on the part of the District.

Solicitations An employee who solicits gifts on behalf of the District or for use in
the fulfillment of his or her professional responsibilities shall comply
with relevant state and federal law and any District administrative
regulations.

All donations solicited on behalf of the District, including solicita-
tions in the name of the District or a campus, or donations solicited
using District or campus resources, become the sole property of
the District.

DATE ISSUED: 2/6/2017 10of2
UPDATE 107
CDC(LOCAL)-A



Columbia-Brazoria ISD

020907
OTHER REVENUES CDC
GIFTS AND SOLICITATIONS (LOCAL)
Web-Based An employee may solicit web-based donations of money or items
Solicitations for use by the employee in fulfilling his or her professional respon-
sibilities or for the District's use, including “crowdfunding.” Howev-
er, an employee shall obtain prior approval from the employee's
supervisor before using the name or image of the District, a cam-
pus, or any student.
DATE ISSUED: 2/6/2017 ADOPTED: 20f2
UPDATE 107
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RE: School Districts and Raffles

Please see Attorney General opinion:

https://www.oag.state.tx.us/opinions/opinions/47mattox/op/1990/htm/jm1176.htm

School Districts are not “Qualified” organizations, so therefore, it is illegal for them or any Activity Fund
to conduct a raffle.



